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    Prefácio




    A empresa norte-americana National Instruments (NI) em 1986 iniciou uma verdadeira revolução ao colocar no mercado o LabVIEW, um ambiente de programação gráfica, cuja linguagem foi chamada pela NI de linguagem G.




    No ambiente LabVIEW, ao invés de se desenvolver código textual, usa-se objetos gráficos na forma de ícones, ou blocos funcionais, que interconectados constroem a lógica desejada, e como consequência a linguagem possibilita o desenvolvimento de aplicações mais rapidamente, devido à maior facilidade de implementação e depuração do código. Ao introduzir no mercado uma linguagem com fundamento gráfico, o LabVIEW fundou um paradigma lógico orientado a fluxo de dados.




    O LabVIEW se caracteriza como um ambiente de programação para o desenvolvimento de instrumentos virtuais, sendo, ainda, multiplataforma e com grande suporte de integração com dispositivos de hardware, desde: Portas Seriais, Interface USB, Ethernet, Bluetooth, Câmaras de Vídeo, até dispositivos controladores avançados baseados em plataformas embarcadas e de lógica reconfigurável. Por todas essas razões, desde seu lançamento em 1986, se tornou uma ferramenta de enorme sucesso, e sendo de amplo uso por engenheiros e cientistas, aplicada em projetos de pequeno, médio e grande porte, usada em empresas e instituições como a NASA e o consórcio do acelerador de partículas do CERN.




    Este livro se propõe a apresentar o ambiente LabVIEW de forma prática, com o objetivo de tornar o leitor proficiente no desenvolvimento dos mais variados projetos, em especial na área de aquisição de dados em plataformas embarcadas (NI-myDAQ, NI-myRIO, Arduino, etc.), podendo se constituir em uma boa opção de livro texto em cursos de Engenharia, Tecnologia e Técnicos nas mais variadas áreas, como as de Computação, Elétrica e Eletrônica, Controle e Automação e Mecatrônica Industrial.




    Prof. Eduardo G. Bertogna, Dr. Eng.




    e-mail: ebertogna@gmail.com
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    Visão Geral do LabVIEW




    
1.1 O que é LabVIEW





    O nome LabVIEW é o acrônimo para: Laboratory Virtual Instrument Engineering Workbench, sendo um ambiente de programação gráfica desenvolvido pela empresa norte-americana National Instruments em 1986, e, desde então, vem se tornando um padrão em aplicações de engenharia e ciência, contando as seguintes características e possibilidades:




    • Ambiente de programação gráfica orientada a fluxo de dados que usa objetos gráficos na forma de blocos funcionais representados por ícones que interconectados constroem a lógica do programa;




    • Com o LabVIEW é fácil e natural integrar componentes de hardware e software no desenvolvimento de aplicações sofisticadas, aplicadas principalmente nas áreas de testes, medições e controle automático;




    • O LabVIEW possibilita o interfaceamento fácil e rápido com uma ampla gama de dispositivos de hardware, tais como: Porta Serial, Interface USB, Câmara de Vídeo, GPIB, e Placas de Aquisição diversas.




    • Possibilita o desenvolvimento para Sistemas Embarcados e Lógica Reconfigurável, usando os dispositivos da NI para essa finalidade como: o CompactRIO e o myRIO, sendo possível o desenvolvimento para sistemas operacionais diversos, como Windows, Linux e Mac OS X, como mostra a Figura 1.1;




    • Oferece uma grande variedade de bibliotecas de ferramentas prontas na forma de blocos funcionais que facilitam no desenvolvimento das aplicações, reduzindo o tempo de desenvolvimento, aumentando a confiabilidade e a flexibilidade, sendo por isto usada por empresas e centros de pesquisa do mundo todo, desde aquelas de pequeno porte, até gigantes como a NASA e o CERN;




    • Completa biblioteca de componentes para realizar análises que ajudam a extrair informações de dados brutos, além de bibliotecas para processamento de sinais e imagem, projeto e simulação de sistemas de controle, matemática e estatística, comunicação de dados e conectividade, dentre muitas outras.
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    Figura 1.1: Integração LabVIEW com HW e SW diversos.




    1.2 O que é um Instrumento Virtual




    Os programas desenvolvidos no ambiente LabVIEW recebem o nome de Instrumentos Virtuais (no idioma inglês: Virtual Instruments, com sigla: VI), nome este derivado do fato de um VI imitar instrumentos físicos reais, tais como osciloscópios, dispositivos multimídia, etc. Estes VIs desenvolvidos com o LabVIEW podem ser extremamente poderosos e sofisticados com interfaces gráficas elegantes e inúmeras funcionalidades. VIs customizados com variados tipos de controles e indicadores podem ser desenvolvidos para uma aplicação específica, em especial em aplicações de testes, medições e controle.




    Na Figura 1.2, a seguir, estão mostrados alguns Instrumentos Virtuais criados com o LabVIEW.




    

      [image: ]

    




    Figura 1.2: Exemplos de Instrumentos Virtuais. Acima Osciloscópio, abaixo Analisador de Sinais Dinâmicos.




    Na Figura 1.3 é mostrado um VI para um sistema de aquisição de dados de emissões de fótons, desenvolvido para pesquisas em Biofotônica.
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    Figura 1.3: Exemplo de um Instrumento Virtual (VI).




    E na Figura 1.4, parte do código do VI acima, na linguagem de programação gráfica do LabVIEW, a linguagem G.
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    Figura 1.4: Diagrama em Blocos do VI da Figura acima.
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    Apresentação do Ambiente LabVIEW




    O ambiente LabVIEW é composto pelo Project Explorer onde o projeto é gerenciado e definido, do Front Panel, do Block Diagram, além do Help do LabVIEW, que pode ser evocado a qualquer instante que haja necessidade. Estes 4 elementos do ambiente LabVIEW podem ser vistos na Figura 2.2. A cada VI em LabVIEW estará associado um Painel Frontal (Front Panel), onde é definida a interface com o usuário, e seu Diagrama em Blocos (Block Diagram), onde o código é definido, como pode ser visto na Figura 2.2. Em execução, apenas o Painel Frontal e visível ao usuário, como seria de se esperar, como na Figura 1.3.
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    Figura 2.1: Principais componentes do ambiente LabVIEW.
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    Figura 2.2: Elementos de um VI no LabVIEW.




    2.1 Criando um novo projeto




    Ao se iniciar o LabVIEW, a seguinte janela, mostrada na Figura 2.3, é apresentada. Nesta janela, as duas opções principais oferecidas permitem: criar um novo projeto em Create Project, ou abrir um projeto já existente em Open Existing.
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    Figura 2.3: Abrindo ou criando um novo projeto no LabVIEW.




    Ao se clicar em Create Project, a janela mostrada na Figura 2.4 aparece, e nesta a opção: Bank Project é automaticamente selecionada, a qual permite iniciar com um projeto vazio.
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    Figura 2.4: Criando um projeto vazio.




    Dentre as opções na janela da Figura 2.4, as principais são: criação de um novo VI vazio - Blank VI, sem a criação do projeto; opção de criação de uma estrutura em Máquina de Estados - Simple State Machine; e criação de programa para Medição Contínua e Armazenamento - Continuous Measurement and Logging; sendo as demais opções mais específicas detalhadas mais adiante.




    Para a criação de um projeto vazio deve, então, clicar em Finish, e assim a janela do Project Explorer será apresentada, como mostra a Figura 2.5. No Project Explorer é onde a criação do projeto tem início, e é onde os arquivos deste são organizados e gerenciados.
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    Figura 2.5: Projeto vazio criado.




    Para adicionar um VI vazio ao projeto, deve-se selecionar: Project=>Add To Project=>New VI, como na Figura 2.6.
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    Figura 2.6: Adicionando um VI vazio ao projeto no Project Explorer.




    Uma vez criado, o VI vazio apresenta a janela do Project Explorer e as janelas do Painel Frontal e do Diagrama em Blocos, ambos vazios, como visto na Figura 2.7.
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    Figura 2.7: VI vazio criado e adicionado ao projeto.




    Em seguida, ao se clicar na janela: Front Panel, em: File=>Save, deve-se atribuir um nome ao VI criado, ver Figura 2.8.
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    Figura 2.8: Atribuindo um nome ao novo VI.
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    Figura 2.9: Atribuindo o nome media_desv_padrão ao novo VI.




    Importante salientar que no Project Explorer uma referência ao arquivo é colocada, e não o arquivo de fato, então, na Figura 2.10, pode-se notar o nome atribuído ao VI na lista de itens do projeto, e também atribuídos as janela do Front Panel e do Block Diagram.
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    Figura 2.10: Referência ao arquivo media_desv_padrão.vi.




    Em seguida deve se salvar o projeto em: Project=>File=>Save, e atribuir um nome ao projeto criado, ver Figuras 2.11 e 2.12.
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    Figura 2.11: Atribuindo um nome ao novo projeto.
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    Figura 2.12: Atribuindo o nome media_desv_padrão ao novo projeto.




    Se o arquivo do VI em disco for deletado, ou sua localização alterada, na referência do Project Explorer continua existindo a relação com a nova posição, 2.13.
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    Figura 2.13: Localização do arquivo do VI no disco.




    Ao se remover no Project Explorer o arquivo “media_desv_padrão.vi”, ele somente será removido do projeto, permanecendo no disco onde foi salvo, uma vez que no Project Explorer este é apenas uma referência ao arquivo.
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    Figura 2.14: Removendo uma referência de um projeto.




    Uma mensagem de confirmação é apresentada quando da remoção da referência do arquivo, ver Figura 2.15.
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    Figura 2.15: Confirmação de remoção pedida.




    No entento, após a remoção de um item, no disco onde o VI foi salvo, este arquivo ainda permanece sem ser deletado.
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    Figura 2.16: Presença do arquivo no disco associado à referência removida no Project Explorer.




    Ao se abrir um arquivo do tipo LabVIEW Project (extensão: .lvproj), o Project Explorer é aberto, e os arquivos associados ao projeto mostrados na janela deste, como o media_desv_padrão.vi, ver Figura 2.17.
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    Figura 2.17: Abrindo um arquivo de projeto .lvproj.




    2.2 Gerenciamento do Projeto




    Adicionando uma Pasta tipo Auto-Populating




    Podem-se adicionar pastas de arquivos ao projeto, de modo a se criar uma estrutura de arquivos organizada, e uma das opções possíveis é a pasta do tipo Auto-populating, que leva esse nome por ser continuamente atualizada quando itens desta são adicionados ou removidos.




    A Figura 2.18 mostra como se pode adicionar uma pasta do tipo Auto-populating ao projeto.
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    Figura 2.18: Adicionando uma pasta do tipo Auto-populating.




    Então, a pasta escolhida é adicionada ao projeto, e sendo do tipo Auto-populating seu conteudo no Project Explorer é atualizada sempre que algum arquivo desta é adicionado ou deletado, ver Figura 2.19.
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    Figura 2.19: Adicionado-se um Auto-populating Folder ao projeto.




    Então, ao se deslocar arquivos para o Auto-populating Folder, no Project Explorer estes aparecerão como mostrado na Figura 2.20.
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    Figura 2.20: Arquivos movidos ao Auto-populating Folder.




    Adicionando uma Pasta tipo Virtual Folder




    Um Virtual Folder é um tipo de pasta organizacional, pois não representa arquivos no disco, mas referências a estes. Para adicionar um Virtual Folder ao projeto, no drop-down menu selecionar: New => Virtual Folder, e digitar um nome a este, por exemplo: “Estatistica”, ver Figuras 2.21 e 2.22.
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    Figura 2.21: Adicionando um Virtual Folder ao projeto.
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    Figura 2.22: Nomeando o Virtual Folder.




    Pode-se converter um Virtual Folder em Auto-populating Folder, através do drop-down menu que se apresenta ao clicar com o botão direito do mouse sobre o Virtual Folder que se deseja converter, escolher a opção: Convert to Auto-populating Folder, como mostrado na Figura 2.23.
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    Figura 2.23: Convertendo um Virtual Folder em Auto-populating Folder.




    Discutiu-se até aqui os itens do Project Explorer na aba Items. Na aba Files, os arquivos são referidos na sua localização em disco.
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    Figura 2.24: Aba Files do Project Explorer.




    No Project Explorer, pode-se fazer mais que simplesmente gerenciar arquivos do projeto, pode-se ainda:




    • Criar Projetos de Sistemas Embarcados Remotos como dispositivos de hardware (como: CompactRI0, ou myRIO, etc.);




    • Criar executáveis e instadores para distribuição aos usuários;




    • Criar bibliotecas compartilhadas (Dynamic Linked Libray - DLL);




    • Distribuir código entre desenvolvedores e integrar o LV com aplicativos de Controle de Versão e Fontes, como o Perforce.




    2.3 O Painel Frontal do LabVIEW




    Como já mencionado, é no Painel Frontal (Front Panel) do VI onde se define a interface com o usuário, constituída de Controles e Indicadores. Controles são elementos para entrada de informações, e Indicadores são os de saída de informações. Os Controles e/ou Indicadores podem ser de vários tipos, dentre eles: Numéricos, Dials, Slides e Gráficos.




    2.3.1 Adicionando Controles/Indicadores no Painel Frontal do VI




    Quando se clicar com o botão direito do mouse no Front Panel aparecerá a janela de palettes de controles, o Controls Palette, como mostrado na Figura 2.25. Nestes palettes pode-se escolher os elementos que irão compor a interface com o usuário, dentre uma grande variedade de controles e indicadores, representando variados tipos de entradas e saídas de dados, tais como: numéricos, booleanos, gráficos, enumerados, strings, matrizes, vetores, dispositivos de hardware, elementos decorativos, dentre outras inúmeras possibilidades oferecidas, que serão apresentadas ao longo dos demais capítulos e seções deste livro.




    Uma vez que o controle ou indicador tenha sido selecionado de um subpalette, este poderá ser colocado no Painel Frontal, escolhendo-se a posição mais adequada a este, e clicando-se novamente com o botão esquerdo do mouse.




    Na Figura 2.26, alguns exemplos de controles e indicadores são mostrados.
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    Figura 2.25: Palettes de controles mostrados no Painel Frontal.
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    Figura 2.26: Vários tipos de controles e indicadores numéricos.




    Os controles e indicadores disponíveis para uso no Painel Frontal são apresentados no Controls Palette em 4 estilos diferentes, em 4 subpalettes, a saber: Modern, Classic, System e Silver, sendo que na Figura 2.25 o estilo Silver está sendo mostrado, e na Figura 2.27, este mesmo subpalette Numeric, mostrados nos estilos Modern, Classic e System.




    Observar nesta Figura 2.27 que nem todos os controles e indicadores de um subpalette tem seus correspondentes nos outros subpalettes.
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    Figura 2.27: Subpalette de controles do tipo Numeric no estilo Modern, Classic e System.




    Pode-se mudar os palettes que estarão visíveis na evocação do Controls Palette, selecionando-se: Change Visible Palettes, como mostrado na Figura 2.28, e então, na janela de seleção que aparecerá em seguida, selecionar os palettes que serão mais usados pelo desenvolvedor dos VIs.
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    Figura 2.28: Seleção de palettes que serão visíveis.




    Cabe salientar que, no Diagrama em Blocos, associado a um Painel Frontal, há a contrapartida do Controls Palette, que se chama: Functions Palette, onde os blocos de funções que constituem a linguagem gráfica do LabVIEW estão organizados em palettes e subpalettes, e o procedimento para se selecionar os que estarão visíveis segue este mesmo procedimento descrito no parágrafo anterior.




    2.3.2 A Barra de Ferramentas do Painel Frontal




    A barra de ferramentas do Painel Frontal, quando o VI não está em execução, é mostrada na Figura 2.29, cujas ferramentas são descritas a seguir.
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    Figura 2.29: Barra de Ferramentas realçada no Front Panel.




    • Botões de Execução: Run [image: ], Run Continuously [image: ], Abort Execution [image: ] e Pause Execution [image: ]; conforme descritos a seguir:




    - Run: executa o VI uma vez apenas, sendo permitido terminar a execução por um controle do Painel Frontal, ou pelo botão Abort Execution;




    - Run Continuously : executa o VI continuamente, não sendo permitido terminar a execução senão pelo botão Abort Execution;




    - Abort Execution: termina a execução do VI imediatamente;




    - Pause Execution: permite pausar a execução do VI imediatamente.




    • Botões de Edição: Text Settings [image: ], Align Object [image: ], Distribute Objects [image: ], Resize Objects [image: ] e Reorder [image: ]; conforme descritos a seguir:




    - Text Settings: permitem editar o tipo, tamanho e cor das fontes, a nível de Aplicação, Caixas de Dialogo, e de Sistema, ver Figura 2.30;




    - Align Objects: usado para ajustar o alinhamento de objetos do Painel Frontal, distribuição e tamanho de objetos, e reorganizar espacialmente os objetos do Painel Frontal, respectivamente, ver Figura 2.31, que mostra as várias opções de alinhamento de objetos.
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    Figura 2.30: Ferramentas Text Editting.
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    Figura 2.31: Ferramenta Align Objects.
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    Figura 2.32: Alinhando controles em um Painel Frontal.




    • Botão de Ajuda: Help [image: ], permite evocar o menu de contexto, no qual, ao se posicionar o cursor sobre um item, a ajuda para esse item aparece na janela de Context Help, ver Figura 2.33.
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    Figura 2.33: Ferramenta Context Help.




    • Botão de Pesquisa: Search [image: ], retorna resultados do sistema de ajuda, e do site: ni.com/zone na internet, ver Figura 2.34, onde um dos resultados da procura foi escolhido e a janela de ajuda aparece com a descrição detalhada do termo pesquisado.
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    Figura 2.34: Ferramenta Search mostrando resultados obtidos.




    2.3.3 VI em Execução




    Ao se acionar o botão Run [image: ], o VI entra em execução, e seu Painel Frontal aparecerá como mostrado na Figura 2.35 (a), onde um VI muito simples para cálculo da média e desvio padrão de N inteiros é mostrado.




    Quando em execução, a barra de ferramentas apresentará apenas os botões de execução: [image: ], com o botão Run de aspecto diferente, além do botão de ajuda. Neste caso, a execução do VI poderá ser terminada pelo botão Stop do Painel Frontal, ou pelo botão [image: ] da barra de execução. No caso do término do VI via botão [image: ], se algum dispositivo de hardware estiver sendo controlado, e este não for adequadamente finalizado, problemas podem ocorrer com este dispositivo, então, nestes casos, o uso deste botão deve ser evitado.




    Se o botão Run Continuously [image: ] for acionado, este terá seu aspecto mudado para: [image: ], e o VI executa continuamente, ou seja, o término da execução só pode ocorrer através do botão [image: ] da barra de execução, sendo que o botão Stop do Painel Frontal não terá função.




    Se o botão Pause Execution [image: ] for acionado, este também mudará seu aspecto para [image: ], e o Diagrama em Blocos aparece com a execução pausada, ver Figura 2.35 (b).




    

      [image: ]

    




    Figura 2.35: VI em execução (a), e VI pausada (b).




    2.3.4 VI com Erros de Construção




    Quando um VI contiver erros de construção, este não poderá ser executado, e o botão Run se apresentará com a aparência de um ícone quebrado: [image: ]. Por conseguinte, ao se clicar neste botão, o VI não executará, e uma janela de erros aparecerá com as descrições dos erros, como mostra a Figura 2.36. Enquanto todos estes erros não forem solucionados, o VI não poderá ser executado.




    Nesta Figura 2.36, o Diagrama em Blocos ali mostrado apresenta dois blocos de função com entradas não conectadas, que são: o bloco de soma - Add, e o bloco de temporização - Wait(ms), além do botão de finalização do laço While-Loop (ver item 3.3.1), que também está sem conexão.




    Para se localizar um destes erros no Diagrama em Blocos, bastará um duplo clique na linha da lista onde erro aparece, ou clicar em Show Error, e o elemento contendo erro começará a piscar no Diagrama em Blocos. Observe os detalhes do erro selecionado na lista, sendo mostrado no campo Details da janela de erros.
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    Figura 2.36: Janela de lista de erros quando um Diagrama em Blocos apresenta erros de construção.




    2.3.5 Aparência do VI em Execução




    Pode-se selecionar a aparência que a janela do VI irá assumir quando em execução através da evocação da opção VI Properties, em: File=>VI Properties, na categoria: Window Appearance, como mostra a Figura 2.37. Nesta Figura 2.38, as 3 aparências que se podem selecionar para um VI em execução: (a) Top-Level Application; (b) Dialog; (c) Default. Na opção: Custom, deve-se clicar em Customize para selecionar as várias opções, como na Figura 2.39.
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    Figura 2.37: Aparência de caixa de diálogo ao VI.
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    Figura 2.38: Aparências de um VI. Em (a) Top-Level Application, em (b) Dialog, e em (c) Default .
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    Figura 2.39: Customizando-se a aparência de um VI.




    Através da caixa de diálogo VI Properties, pode-se, ainda, determinar a posição do VI na tela quando em execução, seu tamanho mínimo, e se este tamanho sofrerá ajuste em diferentes resoluções de tela, ver Figura 2.40.
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    Figura 2.40: Seleção da posição do VI em execução.




    2.4 O Diagrama em Blocos do LabVIEW




    Pode-se comutar do Painel Frontal para o Diagram em Blocos em: Window => Show Block Diagram, ou via teclas de atalho: Ctrl+E.




    E no Diagrama em Blocos (Block Diagram) onde o código do VI é definido, sendo esse código construído através de representações gráficas, usando a linguagem gráfica G, linguagem esta constituída de 5 tipos básicos de objetos, mostrados na Figura 2.41, e detalhados a seguir.
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    Figura 2.41: Componentes básicos do Diagrama em Blocos e suas relações com os objetos do Painel Frontal.




    2.4.1 Componentes Básicos de um Diagrama em Blocos




    • Terminals: são as portas de entrada e saída que possibilitam a troca de informações entre o Block Diagram e o Front Panel. Estes terminais poderão aparecer como ícones, ou em representações gráficas mais compactas, como estão sendo mostrados na Figura 2.41. Pode-se mudar para a representação por ícones com o botão direito do mouse evocando o menu e mudando em: View As Icon;




    • Function Nodes: são objetos do Block Diagram que possuem entradas e/ou saídas, e executam operações quando o VI está sendo executado, sendo identificados pela sua cor amarelo claro. Os Function Nodes podem ser acessados no Functions Palette, ao se clicar com o botão direito do mouse sobre o Block Diagram.




    • Wires: são linhas que transferem dados entre os objetos do Block Diagram. Estas linhas podem ter diferentes estilos e cores para representar diferentes tipos de dados, tais como números, strings de caracteres, vetores, matrizes, etc.;




    • SubVIs: são VIs executadas dentro de um Block Diagram de um VI, e possuem seu próprio Front Panel e Block Diagram. Os SubVIs aparecem com seus ícones personalizados, e para abri-los e mostrar seu Block Diagram e Front Panel, basta um duplo clique do mouse sobre seu ícone. Todo e qualquer VI tem o potencial de ser usado como um SubVI.




    • ExpressVIs: são um tipo especial de SubVI, aparecendo no Block Diagram como um ícone dentro de uma caixa azul, como mostrado na Figura 2.42. Os ExpressVIs quando abertos por um duplo clique mostrarão um Dialog Box oferecendo variadas opções de configuração deste ExperssVI. Maiores detalhes sobre ExpressVI s serão dados mais adiante.
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    Figura 2.42: Detalhes de um ExpressVI em um VI.




    2.4.2 Adicionando Funções/SubVIs ao Diagrama em Blocos




    Functions Palette




    O Functions Palette contém os Function Nodes, SubVIs, ExpressVIs, e constantes que são usados para criar o Diagrama em Blocos do VI em desenvolvimento. Para acessá-lo, e deixá-lo disponível de forma permanente, na barra de menu selecione: View =>Functions Palette, e a janela do Functions Palette se apresentará como mostra a Figura 2.43.
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    Figura 2.43: Functions Palette evocada.




    Subpalettes




    Pode-se, então, navegar entre os Subpalettes, e estes se abrindo, novos Subpalettes poderão estar persentes, e nestes os blocos de funções destes Subpalettes são apresentados, como mostra a Figura 2.44. Esta Figura mostra o Subpalette Timing selecionado, e dentre as funções deste Subpalette, o bloco Wait(ms) foi selecionado.




    Se o usuário, ao selecionar um bloco de função, clicar neste bloco, o bloco pode ser colocado no Diagrama em Blocos na posição escolhida através de outro clique do mouse.




    Para acessar apenas de forma temporária o Functions Palette, clicar com o botão direito do mouse, dentro da janela do Block Diagram, e ao se selecionar um componente qualquer do Functions Palette, esta janela do Functions Palette se fecha, e o componente escolhido pode ser adicionado, na posição desejada, ao Block Diagram, com outro clique do mouse.
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    Figura 2.44: Functions Palette e os Subpalettes.




    Quick Drop




    Outra forma de inserir um Function Node no Diagrama em Blocos, sem recorrer ao Functions Palette, é através da janela do Quick Drop, que é evocado pelas teclas de ataho Ctrl+Space, ou na barra de menu em: View =>Quick Drop, como mostra a Figura 2.45.
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    Figura 2.45: Janela do Quick Drop com um termo parcial digitado.




    Ao aparecer a janela do Quick Drop, digitar o termo que permite encontrar o bloco que se deseja inserir no Block Diagram, e selecioná-lo através de 2 cliques, o que fechará o Quick Drop e o bloco aparecerá no Diagrama em Blocos.




    2.4.3 Barra de Ferramentas do Diagrama em Blocos




    A barra de ferramentas do Diagrama em Blocos e o mesmo que o do Painel Frontal, exceto pela presença de alguns botões adicionais de Debugging, e um botão adicional de edição, como mostrado em realce na Figura 2.46, e explicado a seguir.
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    Figura 2.46: Barra de ferramentas de Debugging do Block Diagram.




    • Botões de Execução Adicionais: Highlight Execution [image: ], Retain Wire Values [image: ], Step Into [image: ], Step Over [image: ], e Step Out [image: ]; conforme descritos a seguir:




    - Highlight Execution [image: ]: quando ativado, este botão se torna amarelo [image: ], e ao se executar o VI, pelo botão Run [image: ], a execução ocorre de forma lenta, tal que o fluxo de dados pode ser acompanhado enquanto a execução ocorre. A Figura 2.47 mostra a exceção em Highlight, e nesta pode-se ver os valores correntes nos nodes que tiveram suas execuções finalizadas. Os nodes que estão esmaecidos são aqueles que ainda não foram executados.
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    Figura 2.47: Execução em modo Highlight.




    - Retain Wire Values [image: ]: quando ativado, este botão se torna amarelo [image: ] e retém o o valor de cada ponto do fluxo de execução, de forma que, se um probe for colocado em um wire qualquer, este imediatamente obtém o valor mais recente que passou por este wire.




    - Step lnto [image: ]: quando se clica uma vez neste botão, um node é aberto e a execução é pausada, quando se clica novamente, este node tem sua primeira ação executada, e pausa a execução na próxima ação da SubVI ou estrutura.




    - Step Over [image: ]: executa um node e pausa no próximo node.




    - Step Out [image: ]: finaliza a execução do node corrente e pausa a execução.




    • Botão de Edição Adicional: Clean Up Diagram [image: ] quando se clica neste botão, todos os nodes e wires do Diagrama em Blocos são rearranjados de forma automática.




    2.4.4 Modos de Visualização de ícones e Nó Expansível




    Há dois tipos de visualização possíveis para terminais e nodes em um Diagrama em Blocos, a visualização padrão, como ícone, e a compacta, ver Figura 2.48. Pode-se mudar de um modo de visualização para o outro, clicando-se com o botão direito do mouse sobre o objeto, e no menu drop-down selecionando-se, ou não, a opção: View As Icon.
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    Figura 2.48: Visualização do diagrama com ícones, e visualização compacta.




    Em relação a SubVI e ExpressVI, por padrão o SubVI será visualizado como ícone, e o ExpressVI como um node expansível (expandable node), ver Figura 2.49. Esta Figura à esquerda mostra um SubVI como ícone - RTD Conv, que converte uma tensão de um dispositivo RTD (Resistance Temperature Detector) para temperatura em graus Celsius. Na mesma Figura, no centro e à direita está mostrado um Express VI para escrita em arquivo de medida, como node expansível, nas visões padrão e expandida, e como ícone.
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    Figura 2.49: Visualização padrão de um SubVI e de um ExpressVI.




    2.4.5 Usando Wires




    Tipos de Wires




    Existem vários tipos de wires, possibilitando o fluxo de diferentes tipos de dados entre os nodes, sendo que cada tipo tem uma representação gráfica diferente. A Tabela 2.1, a seguir, mostra estas diferentes representações associadas aos diferentes tipos de dados existentes, tais como: Floating Point, Numeric Integer, Boolean e String, sendo que estes diferentes tipos de dados serão discutidos em detalhes na seção 3.2. Note a diferença na espessura do escalar para o 1D array, e o duplo traço no caso de arrays 2D.
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    Tabela 2.1: Representações dos vários tipos de wires.




    Interligando Nodes com Wires




    Quando se deseja interligar blocos através de wires, aproximar o ponteiro do mouse sobre o terminal de origem, e se um pequeno ponto aparecer e começar a piscar, com o ponteiro do mouse se convertendo em um rolo de fio: [image: ], então, clicar neste terminal liberando o botão do mouse, e levar o rolo de fio ao terminal destino, e este terminal ao começar a piscar, clicar novamente no botão do mouse para a interconexão se fazer permanente. Pode-se, ainda, usar o Tools Palette, evocado através da barra de menu em: View =>Tools Palette, clicando-se no rolo de fio, como mostra a Figura 2.50. As demais funções oferecidas pelo Tools Palette serão oportunamente discutidas.
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    Figura 2.50: Wiring Tool, ferramenta de interconexão de nodes.




    Deletando e Rearranjando Wires




    Quando se deleta um objeto interligado a outro por uma interconexão (wire), o objeto desaparece, porém, a interconexão permanece, aparecendo como uma linha quebrada, e o botão de Run também aparecerá quebrado, como mostra a Figura 2.51.




    Para se eliminar as linhas quebradas que ficaram após deletar-se objetos, use as teclas de atalho: Ctrl+B, e todas as linhas quebradas são eliminadas ao mesmo tempo. Quando se deseja que a interconexão entre objetos faça uso do caminho mais adequado, eliminando desvios e ramos desnecessários, e dando um aspecto mais limpo ao Diagrama em Blocos, clicar com o botão direito do mouse no wire que se deseja rearranjar, e no menu drop-down, selecionar: Clean Up Wire, ou através das teclas de atalho: Ctrl+U.




    Se desejarmos que o LabVIEW rearrange as interligações de objetos para a forma mais eficiente possível em todo o Diagrama em Blocos, ou de uma área deste apenas, clicar no ícone da barra de ferramentas: Clean Up Diagram/Selection [image: ], ou então, na barra de menu em Edit=>Clean Up Diagram/Selection, e tendo como teclas de atalho: Ctrl+U, como na opção de rearranjo de wires: Clean Up Wire.
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    Figura 2.51: Interconexão quebrada por um objeto deletado.




    2.4.6 Usando Labels




    Para a documentação efetiva do código LabVIEW, usar sempre Labels que estão associados aos terminais, blocos de funções, SubVIs e Express VIs. Para isto, clicar com o botão direito do mouse sobre um objeto, selecionar: Visible Items=>Label.




    Pode-se, ainda, inserir mensagens de texto com um clique duplo do mouse numa área vazia do Diagrama em Blocos, e quando a caixa de edição de cor amarelo claro se abrir, acrescentar comentários e informações úteis, que descrevam as operações do código do VI. Ou ainda, usando o Tools Palette, mostrado na Figura 2.50, clicando-se no ícone A deste: [image: ], e então, clicando-se no local do Diagrama em Blocos onde se deseja incluir o label, digitando-se a anotação desejada.




    2.5 SubVIs




    Como já mencionado rapidamente na seção 2.4, um SubVI é um VI chamado a partir de outro VI, sendo que qualquer VI tem o potencial de se tornar um SubVI.




    Criar SubVIs é atrativo pois, confere ao programa a desejável modularidade presente na maioria das linguagens textuais. O uso de SubVIs proporciona ao programador a possibilidade de implementar os vários módulos de uma aplicação de forma separada, testá-los, e então integrá-los ao VI principal, e ainda, de forma colaborativa com outros programadores.




    2.5.1 Criando um SubVI




    Para transformar uma área de um Diagrama em Blocos, contendo um determinado código, em um SubVI, primeiro deve-se selecionar essa área e na barra de menu selecionar em: Edit=>Create SubVI, como mostra a Figura 2.52. Observe que nesta Figura o SubVI foi salvo como: SubAdd.vi, logo a extensão de um arquivo de um SubVI será o mesmo de uma VI.
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    Figura 2.52: Criando um SubVI a partir de uma área do Diagrama em Blocos.




    Como mencionado antes, um SubVI conterá seu próprio Diagrama em Blocos e Painel Frontal, os quais podem ser vistos com um duplo clique sobre o ícone do SubVI que é colocado no Diagrama em Blocos quando de sua criação. A Figura 2.53 mostra o Diagrama em Blocos e Painel Frontal do SubVI criado, após a edição dos nomes do terminal booleano de entrada e do terminal de saída.
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    Figura 2.53: Painel Frontal e Diagrama em Blocos do SubVI criado.




    Observar que no canto superior direito da janela do Painel Frontal, ao lado do ícone do SubVI, existe um diagrama de conexões, chamado de Connector Pane, que identifica os terminais de entrada e saída do SubVI criado, como mostra a Figura 2.54, onde está mostrado que, ao se clicar nestes conectores, o terminal associado é indicado no Painel Frontal.
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    Figura 2.54: Connector Panel de um SubVI.




    2.6 Criando um Executável LabVIEW




    Após o VI ter sido devidamente testado, o seu desenvolvimento é finalizado, e o passo seguinte é a geração de um executável da aplicação, assim o ambiente de programação LabVIEW não mais é necessário para que a aplicação possa ser executada. A partir do módulo Build Application é possível se criar um executável do VI desenvolvido.




    Para gerar uma aplicação stand-alone do VI, que executa sem o ambiente LabVIEW instalado, deve-se usar a opção: Build Application (EXE) from VI da barra de menu em: Tools, desde que o módulo Application Builder esteja instalado. Assim, a janela da Figura 2.55, a seguir, se apresenta para dar início à criação do executável do VI.
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    Figura 2.55: Janela inicial do Build Application from VI .




    Na janela da Figura 2.55, ao se clicar em Continue, se apresenta a janela da Figura 2.56, a seguir, na categoria: Information, na qual se pode especificar o nome da especificação do arquivo de criação do executável, em: Build specification name, o nome do arquivo de aplicação, em: Target filename, o diretório de destino do executável, em: Destination directory, e por fim, alguma descrição da aplicação em: Build specification description.




    No processo de criação do executável, o arquivo LabVIEW Run-Time Engine é instalado junto com a aplicação, e este permite que o executável rode sem a presença do ambiente LabVIEW. No caso do aplicativo ser instalado em outro PC, ou distribuído a um cliente, o LabVIEW RunTime Engine da versão do LabVIEW usada no desenvolvimento do VI deverá ser baixado e instalado neste PC para que a aplicação possa ser executada.
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    Figura 2.56: Janela de informações do Build Application from VI onde algumas informações devem ser definidas.




    A Figura 2.57, a seguir, mostra a janela do projeto após a criação do aplicativo (Build Specifications).
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    Figura 2.57: Janela inicial do Build Application from VI .




    Ao final da criação do executável dao VI, três arquivos serão gerados e colocados na pasta de destino: o arquivo executável, com extensão exe; um arquivo de configuração, com extensão .ini; e por último um arquivo com extensão .aliases.
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